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1 What is PrePoMax? 

PrePoMax is an open-source pre- and postprocessor for also open-source Finite Element 

Analysis solver CalculiX. PrePoMax is being developed by dr. Matej Borovinšek from University 

of Maribor, Slovenia. The current version is 1.1.1. PrePoMax offers a very user-friendly GUI 

and supports many features provided by the CalculiX solver. It can be downloaded from the 

following website: https://prepomax.fs.um.si/ 

 

Figure 1: PrePoMax user interface  

https://prepomax.fs.um.si/
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2 Currently available analysis features 

• Analysis step types: 

o Static 

o Natural frequency extraction 

o Linear buckling 

o Heat transfer 

o Uncoupled temperature-displacement 

o Coupled temperature-displacement 

• Finite element types: 

o Solid tetrahedrons (first and second order) 

o Shell triangles or quadrilaterals (first and second order) 

o Import of solid wedges (first and second order) 

o Import of solid hexahedrons (first and second order) 

• Material models (isotropic, with optional temperature dependency): 

o Linear elasticity 

o Plasticity 

o Thermal 

• Constraints: 

o Rigid body 

o Tie 

• Interactions: 

o Contact 

▪ Friction 

▪ Gap conductance 

• Initial conditions 

o Temperature 

• Boundary conditions: 

o Fixed 

o Displacement/Rotation 

o Submodel 

o Temperature 
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• Loads: 

o Concentrated force 

o Moment 

o Pressure 

o Surface traction 

o Normal shell edge load 

o Gravity 

o Centrifugal load 

o Pre-tension 

o Concentrated flux 

o Surface flux 

o Body flux 

o Convective film 

o Radiation 
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3 Workflow, general options 

In PrePoMax, three tabs of the model tree dictate the workflow in this software. Each tab also 

activates proper menus in the top toolbar: 

1) Geometry – geometry editing and mesh generation (Figure 2). 

 

Figure 2: Geometry tab of the model tree 

2) FE Model – analysis set up (pre-processing) (Figure 3). 

 

Figure 3: FE Model tab of the model tree 

3) Results – post-processing (Figure 4). 

 

Figure 4: Results tab of the model tree  
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The general steps that should be followed when working in PrePoMax are listed below: 

1) Create a new model (File → New) and select a unit system. 

2) Import CAD geometry for the analysis (File → Import). 

3) Set mesh parameters (Mesh → Meshing Parameters) and generate a mesh (Mesh → 

Create Mesh). 

4) When the mesh is successfully created, proceed to the FE Model part of the model 

tree. 

5) Define material for the analysis (Materials → Create), add Elasticity, Density (for 

performing a modal analysis or using gravity or centrifugal loads) and Plasticity (to 

account for permanent deformations). 

6) Create a new section with the material defined before (Section → Create). Section type 

can be Solid (for using solid elements) or Shell (for using shell elements). In the latter 

case, the thickness must also be specified. Select the part to assign the section to it. 

7) Create a new analysis step. Default step settings are sufficient in most cases. 

8) Optional: create constraints (Constraints → Create), define contact (expand Contact 

container, select Surface Interactions → Create and then select Contact pairs → Create) 

and/or initial condition (Initial condition → Create). 

9) Define boundary conditions (BCs → Create) and loads (Loads → Create). There are 

several types available, and they can be applied to the model in different ways 

(discussed later). 

10) Submit the analysis (Analysis-1 → Run), when it finishes, the results can be viewed 

(Analysis-1 → Results). Various post-processing options will be explained later. 

In PrePoMax, it’s advised to work using node and elements sets as well as surfaces. They can 

be defined before any boundary condition, load, constraint or contact is created and then 

referenced in the definition of the selected feature. However, it’s also possible to add features 

without creating sets/surfaces first. In such cases, the selection tool within the feature window 

will let the user pick entities based on geometry or mesh, depending on the type of feature. 

There are two main ways to work in PrePoMax – use options available in menus (menu bar 

and top toolbar) or select them in the model tree. Some more advanced options can be 

accessed only from the menu bar. 

View controls in PrePoMax: 

- zoom: mouse scroll; 

- rotate model: middle mouse button or keyboard arrows; 

- pan (move model): SHIFT + middle mouse button. 

For selection, use the left mouse button (drag the mouse to use the selection box). 

A search bar is available on top of each of the three main tabs. It can be used to filter geometry, 

FE model and results trees.  
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3.1 File Menu 

The first menu in the menu bar is the File menu shown in Figure 5. 

 

Figure 5: File menu 

It contains the following options: 

- New – create a new model. The following unit systems are available (derived units are 

listed when a unit system is selected): 

o Unitless, 

o m, kg, s, °C, 

o mm, ton, s, °C, 

o m, ton, s, °C, 

o in, lb, s, °C. 

- Open – open a previously created model. 

- Open Recent – open one of the recently used models or clear the list of the recent files. 

- Import – import CAD geometry, mesh or model saved in one of the following formats: 

o Step, 

o Iges, 

o Brep, 

o STL, 

o Universal, 

o Netgen, 

o Abaqus/Calculix inp, 

o Mmg mesh. 

- Save – save changes in the current model. 

- Save As – save the model as pmx file with a given name. 

- Export – export part/model in one of the following formats: 

o Calculix input file, 

o Abaqus input file, 

o Step, 

o Brep, 
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o Mmg, 

o STL. 

- Close Results – close the results from the post-processing part of the model tree 

(saving the pmx model without the results reduces the file size). 

- Exit – close PrePoMax (the user will be asked if the model should be saved first). 

3.2 Edit Menu 

The second menu in the menu bar is the Edit menu shown in Figure 6. 

 

Figure 6: Edit menu 

It contains the following options: 

- Undo – undo the last action. 

- Redo – redo the action that was undone previously. 

- View History – open text file with history of user actions. 

- Regenerate – regenerate the model in case of errors. 

- Regenerate Using Other Files – swap the model’s geometry with a similar one from 

another file so that it is not necessary to redefine the model. 

- Regenerate for Remeshing – remesh the model while keeping all the node sets, 

element sets and surface data defined using mesh-based selections (the model can be 

remeshed without the need to redefine the geometry-based selections).  
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3.3 View Menu 

The following menu in the menu bar is the View menu shown in Figure 7. 

 

Figure 7: View menu 

It contains the following options: 

- Standard Views – apply one of the predefined views: 

o Front/Back, 

o Top/Bottom, 

o Left/Right, 

o Normal, 

o Vertical, 

o Isometric. 

- Zoom to Fit – zoom the model in such a way that it fits in the window. 

- Wireframe – apply a view showing only model edges. 

- Show Element Edges – apply a view showing the model with the finite element edges. 

- Show Model Edges – apply a view showing the model and its feature edges. 

- No Edges – apply a view with showing the model without all edges. 

- Section View – cut the model using a plane defined by a point and a normal or disable 

the section view (this option can be used in post-processing as well). 

- Exploded View – show assembly parts in an exploded view (select exploded view style, 

magnification and scale factor). 

- Show All – show (unhide) all parts of the model. 

- Hide All – hide all parts of the model. 

- Invert Visible Parts – invert the visibility of parts. 

- Color Annotations – use colors to distinguish items of the model based on various 

criteria. 
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Selected options from the File and View menus can be accessed directly using a toolbar menu 

shown in Figure 8. 

 

Figure 8: File and View toolbars 

3.4 Tools Menu 

PrePoMax also features the Tools and Help menus. The Tools menu is shown in Figure 9.  

 

Figure 9: Tools menu 

It contains the following options: 

- Settings 

o General 

▪ Open last file, last file name. 

▪ Save results in .pmx files. 

▪ Default unit system. 

▪ Import mesh → Edge angle. 

o Graphics 

▪ Background: Type, Top color, Bottom color. 

▪ Geometry: CAD deflection. 

▪ Lighting: Ambient component, diffuse component. 

▪ Smoothing: Point smoothing, Line smoothing. 

▪ Widgets: Coordinate system visibility, Scale widget visibility. 

o Default Colors 

▪ Face orientation: Front face color, Back face color. 

▪ General. 

o Meshing – default settings for meshing 

▪ Mesh size: Grading, Elements per edge, Elements per curvature, 

▪ Mesh optimization: Optimize steps 2D, Optimize steps 3D, 

▪ Mesh type: Second order, Midside nodes on geometry, Quad-

dominated mesh, 

▪ Mesh operations: Split compound mesh. 

o Pre-processing 

▪ Color bar: Background type, Draw a border rectangle. 

▪ Selection: Primary/secondary/mouse highlight color. 
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▪ Symbols: Constraints/BCs/Loads color, Symbol size, Node symbol size, 

Draw symbol edges. 

o Calculix 

▪ Calculix: Work directory, Use .pmx folder as work directory, Executable, 

Default solver. 

▪ Parallelization: Number of processors, Environment variables. 

o Post-processing 

▪ Deformation 

• Deformation scale factor: Automatic/True scale/Off/User 

defined, 

• Draw undeformed model: Yes/No, 

• Undeformed model color. 

▪ Limit values 

• Show max value location: Yes/No, 

• Show min value location: Yes/No. 

▪ History output 

• Max number of the history output entries. 

o Legend 

▪ Color spectrum settings 

• Color spectrum type: Cool-warm/Rainbow, Warm, Cool, Cividis, 

Viridis, Plasma, Black body, Inferno, KindImann, Grayscale, 

• Brightness, 

• Reverse colors: Yes/No, 

• Number of discrete colors – in the range of 2-24. 

▪ Color spectrum values 

• Number format: Scientific/General, 

• Number of significant digits – in the range of 2-8, 

• Min/Max limit type: Automatic/Manual. 

▪ Design 

• Background type: None/White, 

• Draw a border rectangle: Yes/No. 

o Status block 

▪ Design 

• Background type: None/White, 

• Draw a border rectangle: Yes/No. 

- Query 

o Point/Node – check the node ID and its value. 

o Element – check the element ID. 

o Edge – check the edge ID and its length. 

o Surface – check the surface ID and its area. 

o Part – check part information (name, type, number of nodes and elements). 

o Assembly – check the number of parts, nodes and elements. 

o Bounding box size – check the size of the model bounding box. 
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o Distance – measure the distance between two nodes. 

o Angle – measure the angle using three points. 

o Circle – measure the circle passing through three selected points. 

3.5 Help Menu 

The Help menu is shown in Figure 10. 

 

Figure 10: Help menu 

It contains the following options: 

- Advisor – opens an interactive helper that will guide the user through the main steps 

to set up the analysis in PrePoMax. 

- Home Page – opens the PrePoMax website in the default browser. 

- About – displays a title card. 

4 Geometry and mesh options 

The Geometry tab of the model tree features two main containers – Parts and Mesh 

Refinements. The first one stores all parts in the model, and the following options are available 

when right clicking the part: 

- Edit – allows editing of the name and the color of the part. 

- Meshing Parameters – displays the parameters for meshing. 

- Preview Edge Mesh – displays points representing nodes in the mesh that will be 

generated (this way, it can be determined whether the size of the mesh is sufficient or 

not before generating it). 

- Create Mesh – starts the mesher and creates the finite element mesh for the part. 

- Copy Geometry to Results – allows to display geometry parts in the post-processing. 

- Hide/Show/Show Only – options to hide and show the selected part. 

- Set Transparency – setting translucency color component of the part. 

- Expand All/Collapse All – expands or collapses all objects listed in the Part container 

- Delete – deletes the selected part. 

4.1 Geometry Menu 

The Geometry menu is shown in Figure 11. 
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Figure 11: Geometry menu 

It contains the following options: 

- Part – selected options discussed above. 

- Create Compound Part – merges two or more parts into one part (body). 

- Swap Part Geometries – swaps part geometries between two parts. 

- Analyze – checks the geometry for the following: 

o Short edges, 

o Close edges, 

o Small faces. 

- Flip Face Normal – flips the shell face orientation. 

- Split a Face Using Two Points – divides a face using two selected points by projection. 

- Find Model Edges by Angle – finds the model (feature) edges that fit into the specified 

angle criterion (only for stl files). 

4.2 Mesh Menu 

The Mesh menu is shown in Figure 12. 

 

Figure 12: Mesh menu 

It contains the following options: 

- Meshing Parameters – settings for the mesher: 

o Mesh size 

▪ Max element size, 

▪ Min element size, 

▪ Grading (0 – uniform mesh, 1 – aggressive local grading), 

▪ Elements per edge (number of elements per edge of the geometry), 
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▪ Elements per curvature (number of elements per curvature radius). 

o Mesh optimization 

▪ Optimize steps 2D (number of optimization steps to use for the 2D 

mesh), 

▪ Optimize steps 3D (number of optimization steps to use for the 3D 

mesh). 

o Mesh type 

▪ Second order: Yes/No, 

▪ Midside nodes on geometry (project the midside nodes on the 

geometry): Yes/No, 

▪ Quad-dominated mesh: Yes/No (for shell parts only). 

o Mesh operations 

▪ Split compound mesh: Yes/No (splits compound part mesh to 

unconnected part meshes). 

- Mesh Refinement 

o Create, 

o Edit, 

o Delete. 

- Preview Edge Mesh 

- Create Mesh 

The Mesh refinement option can be used for local mesh controls. A surface, edge or vertex 

can be selected, and local mesh size can be specified. The mesh refinement can be previewed 

before generating the mesh.  
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5 FE Model options 

Switching to FE Model tab activates the following menus: Model, Property, Interaction, Step, 

BCs, Load and Analysis. They can be used to define various FEM features. The same features 

can also be created using the model tree. 

5.1 Model Menu 

The Model menu is shown in Figure 13. 

 

Figure 13: Model menu 

It contains the following options: 

- Edit 

o Name, 

o Type: Global or Submodel, 

o Absolute zero – value of the absolute zero temperature used for radiation, 

o Stefan-Boltzmann – value of the Stefan-Boltzmann constant used for radiation, 

o Gravitational constant – value of the Newton’s gravitational constant. 

- Edit CalculiX Keywords – a keyword editor that allows adding CalculiX keywords which 

are currently unsupported by PrePoMax. 

- Tools 

o Create Boundary Layer – creates a prismatic boundary layer on the surface, the 

thickness of the layer can be specified (used in analyses with a pre-tension 

load), 

o Find Model Edges By Angle (searches for the feature edges based on the angle 

in the imported meshes),  

o Remesh Elements – remeshes the selected shell region using specified 

max/min element size and max Hausdorff distance for boundaries 

approximation (0.01 is suitable for objects of size 1 in all directions). 

- Node 
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o Renumber All. 

- Part 

o Edit, 

o Transform: Translate, Scale, Rotate, 

o Merge, 

o Hide/Show/Show Only, 

o Set Transparency, 

o Delete. 

- Node set 

o Create, 

o Edit, 

o Duplicate, 

o Delete. 

- Element set 

o Create, 

o Edit, 

o Duplicate, 

o Convert to Part, 

o Delete. 

- Surface 

o Create, 

o Edit, 

o Delete. 

- Reference point 

o Create, 

o Edit, 

o Delete. 

When creating sets, surfaces and reference points, a Set selection window opens (Figure 14) 
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Figure 14: Set selection window 

Sets, surfaces and reference points are named groups of nodes/elements and element faces 

used to define specific FEM features discussed below. Geometry based selection is more 

limited in terms of features, but its definition is not lost when the model is remeshed. FE mesh 

based selection offers more options, but if the model is remeshed the selection definition 

becomes invalid since the mesh has changed. 

Reference points can be created using one of the following methods: 

- Selection/Coordinates, 

- Between two points, 

- Circle center by 3 points, 

- Center of gravity, 

- Bounding box center. 

A reference point position can also be entered by coordinates. The user can also change the 

color of the reference point. 

5.2 Property Menu 

The Property menu is shown in Figure 15. 

 

Figure 15: Property menu 

It contains the following options: 
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- Material 

o Create, 

o Edit, 

o Duplicate, 

o Delete. 

- Material Library – several materials are built into the PrePoMax and the user can add 

new materials to the library as well. 

- Section 

o Create, 

o Edit, 

o Delete. 

Material Library editor is shown in Figure 16. 

  

Figure 16: Material library editor 
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Materials library is stored in the materials.lib file in the base PrePoMax directory. The library 

file is a text-based file that can be edited using any .txt editor, like Notepoad++. It is assumed 

that all material data is stored using the mm, ton, s, °C unit system. But the library file is not 

meant to be edited this way since it is created directly form the material objects using json 

serialization and in not easily readable. 

The library is meant to be edited using the PrePoMax built-in material library editor shown in 

Figure 16. The editor is divided in two sections, a section for library materials and a section for 

the model materials. 

Library materials section 

The material library items consist of categories and materials. Categories are used to organize 

the materials into smaller manageable groups. A new category can be created inside the 

existing category using the Add category button and removed from the library using the Delete 

button. Each item in the library can be renamed using the bottom text field and the Rename 

button. If changes were made to the library, they must be saved using Save button. All 

materials inside one category must have a unique name. 

FE model materials section 

The section for the model materials contains only button Delete which is used to remove the 

materials from the FE model. All materials in the model must have a unique name. 

Using the material library 

To use an existing material in the FE model, the user must first select the material in the library 

material section. Using the right arrow button, the selected library material can be copied to 

the model materials. To add a user material to the material library first the material must be 

created using the Material editor shown in Figure 17. Then the material library editor (Figure 

16) can be used to add the user material to the library. In the material library editor first, a 

desired category must be selected or created and then the left arrow button can be used to 

copy the user material to the library. Once a material is added to the library the changes must 

be saved for future use. 



   
 

 
19 

 

 

Figure 17: Material editor 

Exchanging material data between users 

All material data in the material library can be replaced by replacing the materials.lib file. In 

this way the whole materials library can be sent to a second user. But replacing the library file 

also removes all the changes done by the second user. 

If only a selected material is to be exchanged with the second user, a PrePoMax model .pmx 

file must be used. The first user creates a simple (not empty) model containing the selected 

user material. This file must then be sent to the second user which opens the model file and 

adds the user martial from the file to his materials library using the Material library editor 

(Figure 16). 

When a new material is created, it is possible to define: 

- Density 

- Elasticity 

o Young’s modulus, 

o Poisson’s ratio. 
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- Plasticity 

o Hardening: 

▪ Isotropic, 

▪ Kinematic, 

▪ Combined. 

o Data points (yield stress vs plastic strain). 

- Thermal properties 

o Thermal expansion: 

▪ Thermal expansion coefficient, 

▪ Zero temperature. 

o Thermal conductivity. 

o Specific heat. 

The arrow symbol is used to add a selected property to the new material definition. 

It’s also possible to specify the material’s name, provided the description and include 

temperature dependency (Use temperature dependent data points). 

There are two available section types: 

- Solid section 

o Name – specify the section name, 

o Material – select the material for the section, 

o Region – select the region for the section assignment. 

- Shell section 

o Name – specify the section name, 

o Material – select the material for the section, 

o Thickness – define the shell thickness, 

o Offset – set the offset of the shell mid-surface (shell thickness is the unit), 

o Region – select the region for the section assignment. 

5.3 Interaction Menu 

The Interaction menu is shown in Figure 18. 

 

Figure 18: Interaction menu 

It contains the following options: 

- Constraint 

o Create, 

o Edit, 
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o Swap Master/Slave, 

o Merge by Master/Slave, 

o Hide, 

o Show, 

o Delete. 

- Contact 

o Surface Interaction 

▪ Create, 

▪ Edit, 

▪ Duplicate, 

▪ Delete. 

o Contact Pair 

▪ Create, 

▪ Edit, 

▪ Swap Master/Slave, 

▪ Merge by Master/Slave, 

▪ Hide, 

▪ Show, 

▪ Delete. 

- Search Contact Pairs 

Available constraints include: 

- Rigid body 

o Name, 

o Reference point, 

o Region, 

o Color. 

- Tie 

o Name, 

o Position tolerance – the largest distance from the master surface for which the 

slave nodes will be included in the tie constraint (default: 2.5 % of the typical 

element size), 

o Adjust – projection of the slave nodes on the master surface, 

o Master region, 

o Slave region, 

o Master surface color, 

o Slave surface color. 

The rigid body constraint requires a reference point since it constrains the motion of the 

selected nodes to the motion of the reference point. It is used to define a selected region as 

infinitely rigid (non-deformable). For example, it’s often used when modelling manufacturing 

tools. However, it may also serve as a way to apply moments and remote loads to models. 

Rigid body constraint is the only way to apply a torque to the surface of a solid part (since solid 

element nodes don’t have rotational degrees of freedom). 
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The tie constraint works like a bonded/welded contact. It connects two surfaces in such a way 

that they can’t separate or move relative to each other during the analysis, they are 

permanently connected. Tie constraint is often used to connect parts with dissimilar meshes. 

Contact is a more complex form of interaction between two surfaces than the tie constraint. 

It allows the transfer of forces between touching surfaces. However, contact is a highly 

nonlinear phenomenon and requires careful usage as it may cause convergence issues. When 

defining contact, a surface interaction must be created first. Two options are available: 

- Surface behavior – behavior of the contact in the normal contact direction (pressure-

overclosure relationship) 

o Hard, 

o Linear, 

o Exponential, 

o Tabular, 

o Tied. 

- Friction – behavior in the tangential direction 

o Friction coefficient, 

o Stick slope. 

- Gap conductance – thermal conductance across the contact interface 

o Constant 

o Tabular – pressure and temperature dependent 

When the surface interaction is created, the contact pair should be defined. The options here 

are as follows: 

- Name 

- Surface interaction 

- Method 

o Surface to surface, 

o Node to surface. 

- Adjust – projection of the slave nodes on the master surface. 

- Adjustment size – distance inside which the slave nodes are projected to the master 

surface. 

- Master region 

- Slave region 

- Master surface color 

- Slave surface color 

The Search Contact Pairs tool with exemplary input is shown in Figure Figure 19: Search Contact 

Pairs tool. 
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Figure 19: Search Contact Pairs tool 

The Search Contact Pairs tool allows users to automatically create contact pairs and tie 

constraints. Upon clicking the Search button this tool searches for surface pairs that meet the 

following criteria:  

- distance between them is smaller or equal to the specified distance, 

- angle between them is smaller or equal to the specified angle. 

In addition to these criteria, user may choose whether the pairs are grouped by parts or not. 

Before performing the search, one can change the type of interaction (contact or tie), specify 

previously created contact property definition and choose the type of contact (surface to 

surface or node to surface). For both contact and tie creation, it’s possible to enable or disable 

adjustment. After the search, users can still change the aforementioned settings (as well as 

position tolerance and name of the pair) using the Data window on the right side of the tool. 

In addition, right clicking on the pair in Contact Pairs window brings an option to swap master 

and slave surfaces. When more than one pair is selected, an option to merge by master/slave 

also becomes available. 

5.4 Initial Condition Menu 

The submenus of the Initial condition menu are shown in Figure 20. 

 

Figure 20: Initial condition menu 
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It contains the following options: 

- Create, 

- Edit, 

- Delete. 

The following initial condition types and settings are available: 

- Temperature – can be used to specify the temperature at the beginning of the 

transient thermal or thermo-mechanical analysis 

o Name, 

o Region, 

o Temperature. 

5.5 Step Menu 

The submenus of the Step menu are shown in Figure 21. 

 

Figure 21: Step menu 

It contains the following options: 

- Step 

o Create, 

o Edit, 

o Duplicate, 

o Delete. 

- History Output 

o Create, 

o Edit, 

o Propagate, 

o Delete. 

- Field Output 

o Create, 

o Edit, 

o Propagate, 

o Delete. 

- BC – Boundary condition 
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o Create, 

o Edit, 

o Propagate, 

o Hide, 

o Show, 

o Delete. 

- Loads 

o Create, 

o Edit, 

o Propagate, 

o Hide, 

o Show, 

o Delete. 

- Defined Field 

o Create, 

o Edit, 

o Propagate, 

o Delete. 

5.5.1 Step 

The step types and their options available in PrePoMax are: 

- Static step 

o Name, 

o Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky, 

o Nlgeom: On/Off (enable or disable the geometric nonlinearity – large 

deformations and large displacements), 

o Incrementation: Default/Automatic/Direct (the options listed below are for 

Automatic incrementation), 

o Max increments – maximum number of increments in the step, 

o Time period – time period of the step, 

o Initial time increment – initial value of time increment in the step, 

o Min time increment – minimum time increment allowed, 

o Max time increment – maximum time increment allowed. 

- Frequency step 

o Name, 

o Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky, 

o Perturbation: On/Off (when it’s set to On, preload from previous static step can 

be included), 

o Storage: Yes/No – stores eigenvalues, eigenmodes, mass and stiffness matrix 

in a binary form in a file jobname.eig for further use, 

o Number of frequencies – number of eigenfrequencies to compute. 

- Buckle step 
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o Name, 

o Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky, 

o Perturbation: On/Off (when it’s set to On, preload from previous static step can 

be included), 

o Num of buckling factors – number of buckling factors desired (default: 1), 

o Accuracy – accuracy desired (default is 0.01). 

- Heat transfer step 

o Name, 

o Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky, 

o Steady state: Yes/No – switching between the steady state and the transient 

analysis 

o Incrementation: Default/Automatic/Direct (the options listed below are for 

Automatic incrementation), 

o Max increments – maximum number of increments in the step, 

o Time period – time period of the step, 

o Initial time increment – initial value of time increment in the step, 

o Min time increment – minimum time increment allowed, 

o Max time increment – maximum time increment allowed. 

- Uncoupled temperature-displacement step 

o Name, 

o Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky, 

o Nlgeom: On/Off (enable or disable the geometric nonlinearity – large 

deformations and large displacements), 

o Steady state: Yes/No – switching between the steady state and the transient 

analysis 

o Incrementation: Default/Automatic/Direct (the options listed below are for 

Automatic incrementation), 

o Max increments – maximum number of increments in the step, 

o Time period – time period of the step, 

o Initial time increment – initial value of time increment in the step, 

o Min time increment – minimum time increment allowed, 

o Max time increment – maximum time increment allowed. 

- Coupled temperature-displacement step 

o Name, 

o Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky, 

o Nlgeom: On/Off (enable or disable the geometric nonlinearity – large 

deformations and large displacements), 

o Steady state: Yes/No – switching between the steady state and the transient 

analysis 

o Incrementation: Default/Automatic/Direct (the options listed below are for 

Automatic incrementation), 

o Max increments – maximum number of increments in the step, 

o Time period – time period of the step, 

o Initial time increment – initial value of time increment in the step, 
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o Min time increment – minimum time increment allowed, 

o Max time increment – maximum time increment allowed. 

5.5.2 History Output 

History output is used to generate X-Y plots in post-processing. Available options include: 

- Node output 

o Name, 

o Frequency – results of every N-th increment will be saved, 

o Variables to output 

▪ RF – reaction forces, 

▪ U – displacements, 

▪ NT – temperatures, 

▪ RFL – external concentrated heat sources, 

o Totals – this parameter applies to the external forces, 

o Region – region for creation of the history output. 

- Element output 

o Name, 

o Frequency – results of every N-th increment will be saved, 

o Variables to output 

▪ S – true (Cauchy) stress, 

▪ E – total Lagrangian strain or total Eulerian strain, 

▪ ME – mechanical Lagrangian strain or mechanical Eulerian strain, 

▪ PEEQ – equivalent plastic strain, 

▪ HFL – heat flux, 

▪ ENER – energy density, 

▪ ELSE – internal energy, 

▪ EVOL – volume, 

▪ EBHE – heating power, 

o Totals – this parameter applies to the whole element variables (ELSE, EVOL), 

o Region – region for the creation of the history output. 

- Contact output 

o Name, 

o Frequency – results of every N-th increment will be saved, 

o Variables to output 

▪ CDIS – relative contact displacements, 

▪ CSTR – contact stresses, 

▪ CELS – contact energy, 

▪ CNUM – total number of contact elements, 

▪ CF – total contact forces on slave surface, 

o Totals – this parameter applies to the energy (CELS), 

o Contact pair – contact pair for creation of the history output. 

No history outputs are created by default. 
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5.5.3 Field Output 

Field output is used to create contour plots. Available options include: 

- Node output 

o Name, 

o Frequency – results of every N-th increment will be saved, 

o Variables to output 

▪ RF – reaction forces, 

▪ U – displacements, 

▪ NT – temperatures, 

▪ RFL – external concentrated heat sources, 

- Element output 

o Name, 

o Frequency – results of every N-th increment will be saved, 

o Variables to output 

▪ S – stresses, 

▪ E – total strains, 

▪ ME – mechanical strains, 

▪ PEEQ – equivalent plastic strain, 

▪ ENER – energy density, 

▪ HFL – heat flux, 

▪ ERR – extrapolation error estimator for stress calculations (ERR and ZZS 

are mutually exclusive), 

▪ HER – extrapolation error estimator for heat calculations (HER and ZZS 

are mutually exclusive), 

▪ ZZS – Zienkiewicz-Zhu improved stress (ZZS and ERR are mutually 

exclusive), 

- Contact output 

o Name, 

o Frequency – results of every N-th increment will be saved, 

o Variables to output 

▪ CDIS – relative contact displacements, 

▪ CSTR – contact stresses, 

▪ PCON – contact states for frequency calculations. 

Default field outputs are created in each new step added to the model. 

5.5.4 Boundary condition 

The Boundary Conditions menu is shown in Figure 22. 
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Figure 22: Boundary Conditions menu 

It contains the following options: 

- Create, 

- Edit, 

- Propagate, 

- Hide/Show, 

- Delete. 

The following boundary condition types and settings are available: 

- Fixed 

o Name, 

o Region, 

o Color. 

- Displacement/Rotation 

o Name, 

o Region, 

o DOF 

▪ U1 – translation in X axis, 

▪ U2 – translation in Y axis, 

▪ U3 – translation in Z axis, 

▪ UR1 – rotation about X axis, 

▪ UR2 – rotation about Y axis, 

▪ UR3 – rotation about Z axis, 

o Color. 

- Submodel 

o Name, 

o Step number – global model step number from which to read the 

displacements, 

o Region, 

o DOF 

▪ U1 – translation in X axis, 

▪ U2 – translation in Y axis, 

▪ U3 – translation in Z axis, 
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▪ UR1 – rotation about X axis, 

▪ UR2 – rotation about Y axis, 

▪ UR3 – rotation about Z axis, 

o Color. 

- Temperature 

o Name, 

o Region, 

o Magnitude, 

o Color. 

Fixed boundary condition constrains all the available degrees of freedom (DOF). 

Displacement/rotation BC allows the user to select individual DOFs. The following options are 

available for each DOF: 

- Unconstrained – no boundary condition imposed on this DOF, 

- Fixed – the displacement/rotation from the previous step is fixed in this step, 

- Value (length unit/angle unit) – a prescribed value of displacement (current length 

units for translational DOFs and radians for rotational ones). 

Keep in mind that a fixed option and a value option for various DOFs in the same boundary 

condition cannot be used simultaneously. 

In the case of a submodel boundary condition, each DOF has the following two options: 

- Unconstrained, 

- From global model. 

5.5.5 Load 

The Load menu is shown in Figure 23. 

 

Figure 23: Load menu 

It contains the following options: 

- Create, 

- Edit, 

- Propagate, 

- Hide/Show, 
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- Delete. 

The types of loads and their options are listed below: 

- Concentrated force 

o Name, 

o Region, 

o Force components – components of the concentrated force per node 

▪ F1 – force in the X axis, 

▪ F2 – force in the Y axis, 

▪ F3 – force in the Z axis, 

o Magnitude – resultant force (it’s calculated automatically when the 

components of the force are specified), 

o Color. 

- Moment 

o Name, 

o Region, 

o Moment components – components of the moment per node 

▪ M1 – moment in the X axis, 

▪ M2 – moment in the Y axis, 

▪ M3 – moment in the Z axis, 

o Magnitude – resultant moment (it’s calculated automatically when the 

components of the moment are specified), 

o Color. 

- Pressure 

o Name, 

o Region, 

o Magnitude – value of the pressure load, 

o Color. 

- Surface traction 

o Name, 

o Region, 

o Force components 

▪ F1 – force in the X axis, 

▪ F2 – force in the Y axis, 

▪ F3 – force in the Z axis 

o Magnitude – resultant force (it’s calculated automatically when the 

components of the force are specified), 

o Color. 

- Normal shell edge load 

o Name, 

o Region, 

o Magnitude – value of the shell edge load, 

o Color. 

- Gravity 
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o Name, 

o Region, 

o Gravity components 

▪ F1 – gravitational acceleration in the X axis, 

▪ F2 – gravitational acceleration in the Y axis, 

▪ F3 – gravitational acceleration in the Z axis, 

o Magnitude – resultant acceleration (it’s calculated automatically when 

components of the force are specified), 

o Color. 

- Centrifugal load 

o Name, 

o Region, 

o Axis point – coordinates of the axis point 

▪ X, 

▪ Y, 

▪ Z, 

o Axis direction 

▪ N1 – axis component in the direction of the X axis, 

▪ N2 – axis component in the direction of the Y axis, 

▪ N3 – axis component in the direction of the Z axis, 

o Rotational speed – rotational speed around the axis defined by a point and a 

direction, 

o Color. 

- Pre-tension 

o Name, 

o Type, 

o Region, 

o Auto compute: Yes/No – automatic computation of the pre-tension direction, 

o Magnitude – force magnitude for the pretension load, 

o Color. 

- Concentrated flux 

o Name, 

o Add flux: Yes/No – add flux to the previously defined fluxes, 

o Region, 

o Flux – value of the flux per node, 

o Color. 

- Surface flux 

o Name, 

o Region, 

o Flux magnitude per surface area, 

o Color. 

- Body flux 

o Name, 

o Region, 
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o Flux magnitude per volume, 

o Color. 

- Convective film 

o Name, 

o Region, 

o Sink temperature, 

o Convective film coefficient, 

o Color. 

- Radiation 

o Name, 

o Cavity radiation: Yes/No – an option to make the selected surfaces belong to a 

radiation in a cavity (cavity name has to be specified if this option is switched 

to Yes) 

o Region, 

o Sink temperature, 

o Emissivity – surface emissivity, blackbody radiation is characterized by 1, 

o Color. 

Surface traction load internally applies concentrated forces to each node on the selected 

surface. Their values sum up to the total magnitude specified in the load definition window. 

Despite the name, gravity load can be used to prescribe any type of translational acceleration 

to the structure (such as deceleration due to braking or acceleration of the vehicle). 

Items such as constraints, contact pairs, steps, boundary conditions and loads can be activated 

or deactivated (excluded from the analysis without the need to delete their definitions 

completely). 

Below the menu bar there is a Symbols dropdown list, that allows the selection of how the 

symbols are displayed (None, Model, Step-1, …). 

5.5.6 Defined Field 

Defined fields are used to prescribe predefined values to the nodes. The types of predefined 

fields and their options are listed below: 

- Temperature – can be used to specify temperature field for static or buckle step 

o Name, 

o Define temperature: By value, 

▪ Region, 

▪ Temperature, 

o Define temperature: From file 

▪ Results file, 

▪ Step number. 
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5.6 Analysis Menu 

The Analysis menu is shown in Figure 24. 

 

Figure 24: Analysis menu 

It contains the following options: 

- Create, 

- Edit, 

- Run – submit the analysis, 

- Monitor – open the window that displays solver messages, 

- Results – open results of the completed analysis, 

- Kill – stop the analysis before it finishes, 

- Delete.  
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6 Results options 

The results tree consists of the following containers: 

- Mesh 

o Parts, 

- Results 

o Field outputs, 

o History outputs. 

6.1 Results Menu 

The results menu has two options (Figure 25). 

 

Figure 25: Results menu 

It contains the following options: 

- Part 

o Edit, 

o Hide/Show/Show only, 

o Set Transparency, 

o Color Contours off, 

o Color Contours on, 

o Delete. 

- Transformation – a mirror or a pattern can be applied to the results for visualization 

purposes (use the arrow to add the transformation to the Active part of the window 

to apply it) 

o Symmetry – a symmetry point has to be selected 

▪ Name, 

▪ X, 

▪ Y, 

▪ Z. 

o Pattern 

▪ Linear 

• Name, 

• Number of items, 

• Start point, 

• End point. 

▪ Circular 
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• Name, 

• Number of items, 

• Angle, 

• First axis point, 

• Second axis point. 

In addition to these options, selecting more than one part in the Results tree and right clicking 

on this selection enables users to activate the Merge Parts option that creates a single results 

part. 

Selected post-processing options are also available as shortcuts in the Results toolbar (Figure 

26). 

 

Figure 26: Results toolbar 

These options include, from the left: 

- Undeformed, 

- Deformed, 

- Deformed with color contours, 

- Transformation, 

- First increment, 

- Previous increment, 

- Drop-down list of increments, 

- Next increment, 

- Last increment, 

- Animate. 

There are several settings for animating the results. They are shown in Figure 27. 



   
 

 
37 

 

 

Figure 27: Animation window 

Point/Node query tool has additional functionality in the Results module – it allows the user 

to check the value of the currently shown output variable at the selected node. 


